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1

Introduction

LoggerDataManager is a computer program used with Van Essen
Instruments’ Diver to program and calibrate (if applicable) the meters as
well as download, view and process collected data. In combination with
one or more Divers, LoggerDataManager constitutes a complete and
flexible measurement system.
Once programmed these meters operate independently.
Basic and Advanced version
The Basic is the field version while the Advanced functions are used for
mor e complex adjustments and are notated with the following stamp.

Advanced
Available documentation
The available documentation for LoggerDataManager consists of:
•

Quick Reference Card

•

Online Help file

•

Manual

The Quick Reference Card is made for field use. This card describes how
to start LoggerDataManager on your laptop/PC and how to read out the
measurements from a Diver .
The online help file can be accessed through the Help menu of
LoggerDataManager or by pressing F1. The content of this file is similar
to this printed manual.
This manual will be of assistance in working with LoggerDataManager; it
contains step-by- step explanations of the procedures used with
LoggerDataManager. It is assumed that the reader is familiar with the
construction and operation of Diver s as described in the Diver s’ product
manuals.
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1 Introduction

This manual explains how to…
•

install LoggerDataManager;

•

adjust LoggerDataManager to your situation;

•

program and start Diver s;

•

read out Divers;

•

view, print and export measurements;

•

compensate level measurements made by Divers for
variations in barometric pressure;

•

calibrate CTD- Divers.

2

Installing LoggerDataManager

You install LoggerDataManager as follows:
1.

Open Windows Explorer.

2.

Browse to the CD- ROM or the folder containing the installation
files.

3.

Double click the Setup.exe file. The InstallShield Wizard is
started.

4.

Follow the directions given in the InstallShield Wizard.

You will find more information about the installation of
LoggerDataManager in the Readme.txt on the CD- ROM.

Installing a new version
Two shortcuts (LDM and LDMrepair) will be created in the Programs
folder of the Windows Start menu.
When you install the program for the first time, it will automatically create
a DB folder. The data files accompanying the program will be stored in
this DB folder.
When you install a new version of LoggerDataManager, your DB folder
will not be replaced; however, it is recommended to create a back-up
copy of these files before installation.
In the event that the new version requires structural changes to the data
files, e xisting files would be migrated to the new DB files
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3

Introduction
toLoggerDataManager

3.1 LoggerDataManager
LoggerDataManager enables you to:
•

program settings to Diver s,

•

read out measurements from Diver s,

•

view measurements in either table or graph form.

When you read out the measurements from a Diver, the data series is
automatically stored in a DB under a unique combination of location
code, logger serial number, date and time of reading. This precludes the
accidental overwriting of old measurements with new measurements.
LoggerDataManager allows the user to save the default settings, not
solely the measurement settings, but also the location settings, such as
the altitude above sea level.
The elements contained in LoggerDataManager’s program window are
reviewed in the following section.

3.2 The program window
Here you find a summary of the various components of the program
window, followed by a brief explanation of each component. The various
components will be discussed in more detail in the procedures.
Menu bar

Main tabs

Tabs

Tool bar
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Menu bar
The menu bar provides access to some tasks that cannot be
accessed via buttons on the toolbar.
Tool bar
The buttons on the tool bar access other tasks that can be
performed with LoggerDataManager (or use the hotkeys):
Read settings from connected logger (Alt+S);
Read settings and measurements from connected
logger (Alt+M);
Program settings to connected logger (Alt+P);
Save logger settings as defaults;
Retrieve (default) logger settings;
Access Barometer wizard (Alt+B);
Formatted: English (U.S.)

View Data as Table (Alt+T)
Formatted: English (U.S.)

View Data as Graph (Alt+G)

Advanced

The following tasks are only available in the Advanced
version:
CTD Calibration wizard (Alt+C);
Export Data (Alt+E);

Occasionally, some buttons are displayed in grey. This means
that these functions are not available. The availability depends
on the selected type of Diver, the status of the connected
logger and the selected tab.
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Main tabs
The tabs in the main form structure the functionality of
LoggerDataManager. There are four main tabs:
Measurements, Logger settings, Location and Application
management.
The main tab Measurements is used to select which
measurements and format to view. See section 7, Working
with measurements for more information.
The tabs on the main tab Logger settings are used to view
and adjust the logger settings. See section 5, Taking
measurements with a Diver for more information.
The tab Locations, visible in the Advanced mode only, is
used to enter the data specific to each measuring location.
When programming Divers the location may be selected from
this location list or if a new location is entered it is
automatically added to this list, with default location properties.
The bottom of this tab contains a panel for Location defaults.
It is used to enter defaults to be assigned to new locations,
such as the altitude of the measuring locations above sea
level.
The tab Application management provides access to the
tabs used to adjust LoggerDataManager to your situation. See
section 4, Customizing LoggerDataManager for more
information.
Browse bar
Some of the tabs contain a browse bar:

Go to first record in list;
Go to previous record in list;
Go to next record in list;
Go to last record in list
Add one record to list;
Delete selected record from list;
Cancel new record; changes since the last save will
not be saved to the database.
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Tabs under Measurements
The left-hand side of the tab displays a list of the logger location comb inations for which a measurement series has
been read out at least once. The right-hand side lists each
data set for selected logger . Above these the Diver information
is displayed.
To view a data set, highlight desired logger , select data set
then click on the Table or Graph button or use shortcuts
Alt+T, Ctrl+T, Alt+G or Ctrl+G.
Table displays measurements in a tabular form and allows
user to print all or selected time defined readings
Graph displays the selected measurement series as a graph
which the us er is then able to customize as desired.
Tabs under Logger settings
The tab Logger list, visible in the Advanced mode only,
Advanced
displays all Diver s in database. A Diver can be selected from
this list for the display of the measurement settings on the tab
Read/program logger.
Baro’s only button allows you to display BaroDivers only
Read/program logger can also be used to adjust the settings
and to write them to the logger – provided that the logger is
connected to the PC.
The tab Read/program logger contains two subtabs: Live
update and Default settings . Once the logger is connected to
the PC, the logger’s measurements can be displayed in realtime on the tab Live update. The defaults for use in
programming a logger can be entered on the tab Default
settings . These defaults simplify the programming of more
than one Diver using the same settings.
Tab Application management
This tab contains a variety of program settings, such as the
communications port used to connect the Diver .
The tab can also be used to specify:
−

the user type: Basic or Advanced; the basic version only
contains functionality you need in the field;

−

the language for the user interface and help files (English,
French, Dutch, German or Spanish);
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Advanced

−

the title for the reports you want to print;

−

user name you wish to insert into printed reports and
export files.

Advanced specification is possible for:
−

data and backup directory;

−

maximum storage space;

−

the backup warning when closing LoggerDataManager;

−

logger units:

Unit
temperature

Celsius, Fahrenheit,
Kelvin

level

mm, cm, inch, ft, m, bar
and mbar

Note! It is not possible to select the unit ‘mm’ once at
least one Diver is entered in the database of
LoggerDataManager with a measuring range of more than
30 m.

3.3 Requesting help
You can request help at any time LoggerDataManager is in use. Press
F1, or in the Help menu select the Help option to request help. The
information in the online help is largely identical to the contents of this
Manual.
The table of contents of the help function can be used to browse to the
required subject. Its index and search function can be used for a rapid
search for a specific subject.
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4

Customizing LoggerDataManager

4.1 About customizing LoggerDataManager
Prior to use LoggerDataManager will need to be adjusted to your
situation. Adjustments can be made for:
•

the measuring location ( tab Locations)

•

the program settings (tab Program settings )

4.2 Define measuring locations
Advanced

You use the tab Locations to define the measuring locations that you
use. On reading out measurements from a logger that is not yet included
in this list the logger’s location will automatically be added to the list.

A number of buttons displayed above the location list can be used to
browse through the list, and to enter or delete locations .
The tab Locations includes the area Location defaults. These settings
will be applied to any new locations by default. These defaults can be
changed at any time.
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4.2.1 Enter a measuring location
1.

Click the
button. A new line will be displayed in the
locations list.

2.

Enter the name of the location; any default values will be
assigned to this new location.

3.

Complete the other fields in the line in the event that these
parameters are applicable to your situation or if they differ from
the default values:
−

Alt is used to enter the altitude of the measuring location
above or below sea level. This is desirable because of the
lower barometric pressure at high altitudes Values can be
entered between - 300 m and 3000 m. The offset is 10 cm
water column per 100 metres altitude. The altitude may
also be expressed in feet.

Note! If the level unit on the Application management >
Program settings tab is set to feet or inches, the altitude on
the Locations tab is displayed automatically in feet [ft]. For all
other level units, the altitude is displayed in metres [m].
−

Coord.1 and Coord.2 are used to enter the optional
coordinates of the location, based on a system of
coordinates of your choice.

−

You can enter a correction factor for contaminated or salt
water under Density. In the case of more or less pure
fresh water, this factor can keep the default value as
defined at installation of the LoggerDataManager: '1'.

−

Under BaroLocation, you can enter the location of the
BaroDiver you wish to use to compensate level
measurements of a Diver for air pressure variations or
double click on desired Baro from drop down list and it will
be added to BaroLocation field.

−
Note! For loggers that require no barometer compensation the
BaroLocation column can remain empty.
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When you read out the settings of a Baro Diver, its
location is added automatically to the location list and also
added to the picklist of the BaroLocation column. See
section 8, Compensation of Diver level measurements for
details about using the Barometer wizard for
compensating measurements.
Note! Because the air pressure measured by a barometer will
be subtracted from the absolute pressure measurement taken
by Divers, it is essential for barometers to be positioned as
closely as possible to the altitude above sea level of the Divers
they are being used to compensate.
−

Ext. ref. level (text field) is used to enter a description of
the reference level used in calculating level
measurements made by Divers. This imparts the
measurements with a practical significance; examples are
an ordnance level or the top of the borehole.

−

The height of the pressure sensor in relation to the
selected external reference level is displayed under Level
offset (numerical field) on the Locations tab.

4.

Click the

button. The location has now been added.

4.2.2 Enter default location settings
Location settings applicable to a number of measuring locations can be
set as defaults. The defaults are automatically assigned to any location
when you define a new location.
You fill in the default settings on the tab Location defaults at the bottom
of the tab Locations .
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The following location settings can be entered as defaults:
Standard water
density

standard specific gravity of the water;
correction for the density of water, e.g. in
brackish water.

Altitude

the altitude above sea level

Baro-Location

the location of the Baro Diver

Manual measurement
from

the description of the reference level for the
master level measurement

A description of these settings is given in the previous sub-section.

4.2.3 Delete a measuring location
1.

Select the location you want to delete.

2.

Click the

3.

Click OK to delete the location.

button. The Confirm dialogue box is displayed.

A message will be displayed in the event that there are still
measurement series or loggers stored by LoggerDataManager
which refer to this location and the location will not be deleted.

4.3 Adjust program settings
A number of program settings can be adjusted on the Application
management tab
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Selected COM- port
Select the communications port (COM or USB) that will be
used t o connect the Divers. If you want to use the USB-port,
refer to the Windows system information which COM-port is
used as USB- port.
Report title
Entering a report title is optional. The report title is included in
printouts of the measurements (reports).
User name
This name is incorporated into the headings of printed reports,
and export files in MON format.
User type
Select the Basic or Advanced version of LoggerDataManager.
These advanced functions are disabled when the Basic
version has been selected :
−

the tab Logger list (under tab Logger Settings );

−

the tab Locations

−

the selection buttons for units of level, temperature and
altitude (under tab Application management);

−

the function Calibrate CTD (on the tool bar);

−

the tool button Export files and the menu option Import
files

Language
Select your language of preference. It takes a few seconds for
the user interface to adapt to the new language. The Help
f unction (F1) will always call help texts in the selected
language.

Advanced

The following settings are only available in the Advanced version:
Data directory
The default directories to w here the database files with all
logger settings and measurements are stored are ‘DB’, a
subfolder of your installation folder.\LDM\Exe. To store or
access DB files in a different location use the Browse button
to locate the folder .
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After changing the database directory, LoggerDataManager
will notify you that the new database will be used at restart.
LoggerDataManager closes automatically after
confirmation of this message.
Note: If you select a directory where no complete database is
available, LoggerDa taManager reports this and resets itself to
the default database that was created at installation. This
database is always assumed to exist.
Backup directory
LoggerDataManager automatically makes backup MON- files
of all data read from the loggers. Those MO N-files are stored
in a backup directory (always on a local drive) when you read
loggers in the field. The default backup directory is
subdirectory:
C:\Program Files \LDM\Exe\BackupsOfReadings \.
Use the Browse button to change the directory.

Note: it is recommended to save the MON- file backups
regularly on a network drive in the office after each outdoor
reading of loggers. The MON-file backups can be imported
into LoggerDataManager ( File > Import ) if data lost.
Threshold value warning on storage space for MON-files as backups
This feature has a value of 10 MB disk space for storing MONfiles at installation. If the contents of the back- up folder
exceeds the threshold value, LoggerDataManager will warn
you that this value has been exceeded.
You can save storage space by moving the backup MON- files
regularly to a tape or cd-rom in the office.
Show warning to backup the database
Select this check box if you want LoggerDataManager to
remind you to make a backup of the database files Logger
units
Select Units of Measurement
Enter the units to be used for the presentation of temperatures
and levels. The units that are selected do not need to be
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identical to the units used in the programming of the Diver s.
When the measurements are read from a logger, they will
automatically be converted into the selected logger units if the
logger’s units differ from the units in LoggerDataManager.
A change in the level unit will result in the conversion of all
level data currently stored in the system – a procedure that
may require some time! A progress bar will appear during
conversion.
Note! It is not possible to select the unit ‘mm’ if at least one
Diver has been entered in the database of
LoggerDataManager with a level range of 30 m or more. The
reason is the Diver’s finite resolution of the absolute pressure
measurement.
Changes to units bar and mbar are special, because these
are pressure units, not level units. These units are suitable to
measure absolute pressures, which are useful for some
industrial applications. This means that barometric
compensation, physical corrections and conversion to an
external reference level are irrelevant.
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5

Taking measurements with a Diver

5.1 About taking measurements with a Diver
To take measurements with a Diver , follow these steps as listed below.
Each step is explained in more detail in the following sub-sections.
1.

Connect the Diver to the computer.

2.

Read the measurement settings from the Diver .

3.

Adjust the measurement settings.

4.

Program the new settings to the Diver.
If so required the measurement settings can be saved as
defaults for programming other loggers of the same type.

5.

Set the Diver to the correct time, and start the measurements
immediately or in the future.

5.2 Connect a Diver to your computer
The Diver must be connected to the computer before the measurement
settings can be read out from the Diver and the Diver can be
programmed.
The method used to connect a Diver depends on the Diver type, the
application and the manner in which the logger is installed. The following
sections explain the connection method for each type of Diver .

5.2.1 Connect a Diver
The method used to connect Divers depends on the manner in which the
Diver is installed in the borehole:
•

Divers suspended in the borehole on a steel cable will need to
be removed from the borehole prior to connection. The Diver
is connected to the computer using a Reading Unit.

•

Divers suspended on a DRC (Direct Read Cable or Diver Data
Cable) do not need to be removed from the borehole , simply
use an interface cable to connect the Diver to the computer.

LoggerDataManager by Van Essen Instruments

Page 16

To connect a Diver suspended on a steel cable:
1. Connect the read-out unit to the computer.
2.

Remove the Diver from the borehole.

3.

Unscrew the protection cap.

4.

Fit the inverted Diver into the read- out unit.

To connect a Diver suspended on a DRC or DDC:
1. Connect the interface cable to the computer.
2.

Unscrew the protective cap from the head of the DRC or DDC

3.

Connect the other connector of the interface cable to the head
of the DRC or DDC.

Note! Replace protective cap as soon as possible. The Diver consumes
power when the optical connector is exposed to light, reducing the life of
the battery.
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5.3 Read out measurement settings
The Diver is now connected to the computer. Before you can program the
instrument you need to read out the current measurement settings.
To read out measurement settings:
• Click the Read settings from connected logger button.

What happens now?
Tab Read/program logger is automatically displayed.
Logger is already known to LoggerDataManager
LoggerDataManager locates the corresponding record in its
database; LoggerDataManager reads the logger’s current
measurement settings and replaces the old values in the
database.
Logger is new to LoggerDataManager
When LoggerDataManager does not recognize the logger the
program will display the message “Warning: settings for a new
logger will be inserted . Divers with a level range of 150 cm
(BaroDivers) are immediately recognized as barometers, and
are assigned with a ‘B’ in the column Baro? in the logger list.
The message “Is the connected diver being used as a
barometer” will be displayed if not a BaroDiver. Then a
message giving location name will appear with a reminder to
modify default properties.
In the event that the location code of the logger that has been
read is also new, LoggerDataManager will add this location to
the locations list .
LoggerDataManager assigns the default location settings to
the new location. However, in the event that the altitude read
out from the Diver differs from the default altitude then the
actual altitude will be saved instead.
If the location code is already known but the altitude differs
from the former altitude, a new location code is automatically
Note! Altitude may not be altered once readings have been
taken unless location code changes.
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The sub tab Live update at the bottom of the tab displays
information about the logger’s status .
Note! If you encounter reading problems, please refer to
section 10, Solving problems.

5.4 Adjust measurement settings
You have connected the Diver to your computer and read out the current
settings. Now you want to change the settings. See section 5.4.2 for
more information about the measurement settings of a CTD- Diver.
After adjusting the measurement settings, you program those settings to
the Diver (see also 5.5 Program measurement settings to a Diver).

5.4.1 Adjust measurement settings of a Diver

On the tab Read/program logger in the Logger Settings tab you can
change the settings of the selected logger.
Location
Here you can enter the location of the selected Diver. With the
button New/Lookup you can toggle between entering a new
location and selecting an existing one. The settings of a new
location can be changed on the tab Locations.
Note! Avoid characters colon ( : ), greater than ( > ), less than ( < ),
double quote (“), pipe ( | ), question mark ( ? ), slash forward ( /) and
slash backward ( \ ) in your location codes. Location codes are often used
in names of export files, which are stored in the Windows directory
system. These characters are not allowed in filenames under Windows.
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Logger No. & Type
The instrument type and corresponding logger number (serial
number) cannot be changed; they are programmed into the
Diver. This data is also present on the Diver itself (see section
'Technical information' in the Diver manual).
Instrument code
Here you can enter your own identification code for the
connected Diver.
Altitude
This is the altitude of the measuring location in relation to sea
level. Because altitude is a characteristic of the location, you
can adjust it via Locations .
PLEASE NOTE: Divers of Part Number Series 400 or
greater are not affected by altitudinal changes.
Sample rate
This field appears when you select the sample method Event
based or Fixed (minimum: 0.5 sec; maximum: 99 hours). You
receive an error message at an attempt to enter a value
outside these limits.
Sample method
Here you can choose the sample method; the way in which
the Diver takes measurements and stores them. Depending
on the chosen method, other fields you need to fill in will
appear. You can read more about sample methods in Select a
sample method.
Variation of range
This field appears when you select the sample method Event
based.
Manual measurement
Enables the user to enter a manual measurement value and
its date/time right away after the start of a new series of
measurements; it is stored as a logger setting and
automatically assigned to the next series that is read out from
this logger.
Channel settings
On the right-hand side of the window, you can see the
channels and the ranges. In the white fields you can enter
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your own names for the channels; numerical values of the
ranges cannot be changed.

Select a sample method
A sample method is the method a Diver uses to take samples and store
them. The following methods are available for a Diver:
•

Fixed

•

Event based

•

Setup A, B or C

•

User defined (Cera- diver & Micro- Diver only)

Fixed
When you select this method, the Diver takes and stores s amples on a
regular basis.
If you select this method in the field Sample method, the field Sample
rate appears. There you choose the time between two consecutive
measurements.
Example
With a 10- second sample rate or period, the Diver takes a
measurement every 10 seconds on both channel settings
(water level and temperature) and stores this value in its
internal memory. The maximum number of measurements is
24,000. In this case, the internal memory will be full after 2
days, 18 hours and 40 minutes. The Diver stops taking
measurements when the memory is full.
Note! A measurement will be stored as a record with the data
date + time + level + temperature. All measurements are
imported together as one series in LoggerDataManager .
Event based
When you select this method, the Diver compares each sample to the
last stored sample. A new sample is only stored when the water level in
the new sample differs at least a given percentage from the level in the
last stored sample. If you select this method, thef fields Sample method,
Variation & Sample rate must be completed. The Variation is entered
as a percentage of the range of the Diver. The percentage must lie
between 0.1% and 25%.
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Example
Suppose you entered a variation of 10% for a Diver with a 5m
measuring range and a sample rate of 30 minutes. The Diver
will then measure the water level every half-hour and compare
it with the last stored level. It will only store the new level if it
differs 50 cm (i.e. 10% of 5m) from the last recorded level.
Note! Taking samples costs energy, even when the samples aren't
always stored. It is therefore more likely that this sample method causes
the battery to be empty before the Diver memory is full.
Setup A
This method for a short- term pump test consists of three steps with fixed
sample rates and time intervals .
Step
1
2
3

Time interval
0- 10 min.
10-100 min
100-1,550 min.

Sample rate
0.5 sec.
1 sec.
5 sec.

25.8 hrs.

Measurements
1,200
5,400
17,400 (41,400)*
max 24,000 (48,000)*

Setup B
This method for a standard pump test consists of four steps with fixed
sample rates and time intervals.
Step
1
2
3
4

Time interval
0- 10 min.
10-100 min
100-1,000 min.
1,000- 9,460 min.

Sample rate
1 sec.
5 sec.
10 sec.
30 sec.

157 hrs. and 40 min.

Measurements
600
1,080
5,400
16,920 (40,900)*
max 24,000 (48,000)*

Setup C
This method for a long-term pump test consists of five steps with fixed
sample rates and time intervals.
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Step
1
2
3
4
5

Time interval
0- 10 min.
10-100 min
100-1,000 min.
1,000- 10,000 min.
10,000- 428,200 min.

Sample rate
5 sec.
20 sec.
1 min.
5 min.
20 min.

297 days

Measurements
120
270
900
1,800
20,910 (44,910)*
max 24,000 (48,000)*

* applies to CeraDiver & MicroDiver only
User Defined (Cera- Diver & Micro- Diver only)
By using the EDIT button you can create a custom sampling protocol. In
lower left corner of the template you may select add a new row, delete an
existing row or edit an existing row. You may give each protocol a unique
name and description for easy identification. After defining a base sample
rate , you can program the number of samples to be taken at various
intervals (which are multiplied by base sample rate to determine sampling
rate ) until samples remaining are 0 . Maximum number of steps is 10.
Maximum interval is 250.

Example: Define the base sample rate as 30 sec. Interval column is
number of base sample rates between recording samples. If interval
selected is 1, sample rate is 30 sec., if interval is 2 sample rate is 60 sec.
Program number of desired samples at various intervals until number of
samples remaining reads 0.
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5.4.2. Adjust conductivity measurement settings for a CTD- Diver
Conductivity Channel settings
On the right-hand side of the window, you can see the
available channels and ranges. In the fields you can enter your
own names for the channels; numerical values of the ranges
cannot be changed.
For the conductivity channel, you can select the type of
conductivity you want to me asure. (See figure below.) You
choose between conductivity and specific conductivity, and
also between measuring ranges 0 - 30 mS/cm or 0 - 80
mS/cm (in the Select range box).
If you choose Conductivity, the CTD- Diver measures the
conductivity of the liquid. If you choose Specific
conductivity, the CTD- Diver immediately converts the
measured conductivity to conductivity at 25°C (77°F).

Note! A CTD- measurement will be stored as a record with the
data date + time + level + conductivity. All measurements are
imported together as one series in LoggerDataManager .
Event based
When you select this method, the CTD- Diver compares each sample to
the last stored sample. A new sample is only stored when the new
sample differs at least a given percentage in conductivity from the last
stored sample. The maximum number of samples in a range is 16,000.
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Example
Suppose you entered a variation of 10% for a CTD-Diver with
a 0-80 mS/cm measuring range and a Sample rate of 30
minutes. The CTD-Diver will then take a measurement every
half-hour and compare it with the last stored conductivity. It will
only store the new measurement (conductivity, temperature
and depth) if the conductivity differs 0.8 mS/cm (i.e. 10% of 80
mS/cm) from the last stored conductivity.
Note! Taking samples costs energy, even when the samples aren't
always stored. It is therefore more likely that this sample method causes
the battery to be empty before the Diver memory is full.

5.5 Program measurement settings to a Diver
The measurement settings of the Diver connected to the PC have now
been read out and adjusted. The next step is to program the new
measurement settings to the Diver connected to the PC.
Note! When the Diver still contains data in storage, it is vital you first read
out these measurements before you start the Diver . When a Diver is
started, the stored data in the memory is deleted. Once the
measurements are read, they are automatically saved in
LoggerDataManager. See sub-section 6.1.
To program measurement settings to a Diver:
• Click the Program settings to connected logge r button.

LoggerDataManager detects the status of the connected
logger; if it is not ‘STOPPED’, this is reported to you and the
programming is cancelled. If the programming actually takes
place, the buttons Start now and Future start are activated;
the Diver can now be started.

LoggerDataManager by Van Essen Instruments

Page 25

5.6 Use measurement settings as defaults
Measurement settings of the selected Diver can be saved as defaults.
They can be retrieved when programming a different logger of the same
type in the same manner. This feature is particularly convenient when
several Diver s are to be programmed with the same settings.
It is, however, not necessary to make use of all the defaults when you
program a Diver. You can make the retrieval selective by unchecking one
or more ‘active’ checkboxes of the default settings. After this retrieval you
can change the logger settings.
The defaults can be entered on the tab Default settings at the bottom of
the tab Read/program logger.

5.6.1 Save measurement settings as defaults
•

Click the Save logger settings to defaults button in the tool
bar once the settings have been written to the logger.

5.6.2 Use default measurement settings
1.

On the bottom of the Read/program data logger tab, click the
Default settings tab.

2.

Check or uncheck the Active boxes of the default settings,
according to your needs.

3.

Read the Diver’s current measurement settings. See sub section 5.3, Read out measurement settings for details.

4.

Click the Retrieve logger settings from defaults button in
the tool bar once the current measurement settings have been
read out.

If necessary, enter additional changes to the settings.
5.

Program the Diver with the settings. See sub- section 5.5
Program measurement settings to a Diver for details.
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5.7 Start measurements
The Diver can be started immediately after the instrument has been
programmed with the new measurement settings. You start the Diver on
the Read/program logger tab, under the Logger settings main tab.

A Diver can be programmed to start immediately, or with a
future start date/time. In the latter case you have to program
the future start date and time into the Diver .

It is important to ensure that the logger’s internal clock is set to the right
time before starting the logger, since each measurement is marked with
the date/time at which it was made.

5.7.1 Set the correct time
To synchronize the logger’s clock with the system clock:
• Check the Synchronize logger time to system time at start
box.
When the Diver is started the logger’s clock will be
synchronized with the system clock of your computer.
To set the logger’s clock to any required date and time:
1. Click the Manual adjust button. This will display the Adjust
logger date / time dialogue box.

This displays the current date and time.
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2.

Select the required date and time.

3.

Click OK.
The date/time settings will automatically be transferred to the
logger’s internal clock.

5.7.2 Start a Diver
A Diver can be started immediately, or at a time you set.
Note! When the Diver still contains data in storage, it is vital you first read
out these measurements before you start the Diver . When a Diver is
started, the stored data in the memory is deleted automatically. Once the
measurements are read, they are then automatically saved i n
LoggerDataManager. See chapter 6.
You can easily check how many measurements a Diver still contains.
Click the Start live updating button on the tab Live update on the
bottom of the tab Read/program logger. The information then displayed
includes the cur rent value in the field Space left for.. [meas.] in logger
memory.
To start the Diver immediately:
• Click the Start now button. LoggerDataManager warns you
about saving the data. It also calculates when the logger
memory will be full.
•

The Status field on the tab Live update indicates that the
logger has been started, and displays the first measurement.
The measurements can be followed in real- time. See subsection 6.3.2 Read out current measurements for details.

To start the Diver at some date/time in the future:
1. Click the Future start button. This will display the Future start
dialogue box.
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2.

Enter the required date and time.

3.

Click OK. The time setting will be transferred to the logger.
The Status field on the tab Live update indicates that the
logger will be started at the some time in the future, followed
by a display of the time setting .

Smart Future Start option:
Selecting the Smart Future Start option tells the diver to resume sampling
at the previously designated intervals.
Example : Measurements were recorded at 24 hr intervals at 8 a.m.
daily. The diver is stopped, Memory downloaded & restarted. If Smart
Future Start option selected next recorded measurement will be @ 8
a.m. the following day regardless of the time the Diver restarted.

NOTE: This feature will only work correctly is scheduling sampling
does not occur while diver stopped.
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6

Reading out a Diver

6.1 About reading out a Diver
This chapter explains how you can read out measurement values from a
Diver.
You can read out the measurement settings of a logger , or the
measurement settings combined with the stored measurement values .
By only reading in the measurement settings, you can check how the
logger has been programmed, e.g. whether it has started or stopped. In
this case, the stored measurement values are not read into
LoggerDataManager.
The Diver can be stopped prior to reading out the data, and then
restarted; however this is not necessary, since the data can be read out
while the logger continues to store measurements. This implies that when
the same Diver is read out again some of the measur ements will be
duplicated. In that case the duplicate measurements can be deleted. See
sub-section 7.7, Delete measurements for details.
Subsequent to reading out the Diver data the measurements will
automatically be saved in LoggerDataManager’s database. Measurement
values can be exported manually in a number of different formats. See
sub-section 7.6, Export measurements for details.
Reading out the Diver adds measurements to LoggerDataManager’s
database.

6.2 Stop measurements
The Diver is connected to the computer. Prior to reading the
measur ements the logger can be stopped. It reduces the risk of
interference between the reading process and a measurement action.
1.

Read the measurement settings from the logger with the Read
settings from connected logger button.

LoggerDataManager reads out the logger measurement
settings but not the measurements themselves. See subsection 5.3, Read out measurement settings for details.

LoggerDataManager by Van Essen Instruments

Page 30

Note! If you encounter reading problems, see section 10
Solving problems .
2.

Click the Stop button on the Read/program logger tab. The
logger will stop immediately. The logger status in the Live
Update tab with now read stopped.

6.3 Read out a Diver
The Diver has been connected to the computer and, when necessary,
Diver measurements have been stopped. You can now read out the
measurements; they will be automatically saved.
The system can be tested with a direct read- out of measurements the
Diver has just taken. The Diver needs to have been started for this.
LoggerDataManager repeatedly displays the current measurements, but
does not save them.
Note! When the Diver ’s memory still contains measurement data, it is
vital you first read them out before you start the Diver. When a Diver is
started, the stored data in the memory is deleted automatically. Once the
measurements are read, they are then automatically saved in
LoggerDataManager.

6.3.1 Read out all measurements
•

Click the Read settings and measurements from
connected logger button.

What happens now?
LoggerDataManager locates the corresponding record in its
database.
When LoggerDataManager does not recognize the logger, it
displays a message stating that a new logger needs to be
added to the list of loggers. Divers with a level range of 150
cm (BaroDivers) are immediately recognized as barometers,
and are assigned with a ‘B’ in the column Baro? in the logger
list. For all others LoggerData Manager asks ‘Is the
connected logger being used as a barometer?’ This question
is not displayed when using CTD- Diver . If answered yes, it will
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then be added to logger list as a Baro. The indicator can
always be changed by the user in column Baro? in the logger
list.
In the event that the location code of the logger is new, then
LoggerDataManager will add this location to the locations list.
LoggerDataManager assigns the default location settings to
the new location. However in the event that the altitude read
out from the Diver differs from the default altitude then the
actual altitude will be saved instead.
If the location code is already known but the altitude differs
from the former altitude then a new location code is
automatically generated. The new altitude is assigned to it,
replacing the last 4 characters of the location code with
“~nnn” , where nnn stand for a sequence number, starting at
000. This is augmented as much as necessary to maintain
uniqueness of the location codes.
It is recommended to change the automatically generated
location code immediately into a code that fits your coding
system.

Progress reading data
The measurements and relevant settings, will now be read out
and automatically saved in LoggerDataManager. The
Progress reading logger data dialogue box displayed in the
middle of the screen shows the read-out progress. Click
Cancel to stop the read out. Measurements read out until that
time will not be saved by LoggerDataManager.
Note! If you encounter reading problems please refer to
section 10 Solving problems .
The measurements have now been read out and stored, and
can now be viewed. The Diver can be restarted if it was
stopped to read out the measurements. See section 7,
Working with measurements and sub-s ection 5.7 , Start
measurements for details.

6.3.2 Read out current measurements
Make sure the logger is properly connected to the computer.
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1.

Click the Read/program logger tab.
The tab Live update displayed on the bottom of the tab
indicates the logger’s status and the value of the latest
measurement.

2.

In the Update period field, enter the update period between
two consecutive retrievals of the latest measured values.
For example, when the Diver connected to the computer
makes a measurement once a minute the update period can
be set to 60 seconds – obviously a shorter period serves no
purpose.

3.

Click the Start live updating button to continually read out the
current value. The button text will change to Stop Updating.

6.4 Import measurement files
Advanced

Measurements with the following file formats can be imported:
•

Text files with the extension .MON or .LEV

•

Character-based files usually have the extension .DAT

To import measurement files:
1. In the File menu, click Import files. The Open MON- or DATfiles (-text or character) dialogue box is displayed. The
import folder that was used last is the n displayed.

2.

Browse, if needed, to the folder containing the file(s) to be
imported.

3.

At first, the MON- files are visible. If you want to import a DATfile, select Char -files in the field File type.
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4.

Select the file you want to import. You can also select multiple
files to import. Press down and hold the CTRL key and click
the files you want to import or press and hold the SHIFT key
and click the first and the last file of the range of files you want
to import.

5.

Click the Open button. The measurements in the file will be
imported into LoggerDataManager database. If you select
more than one file in step 4, the data will be imported file by
file. It is not possible to cancel the import.

What happens now?
Logger is known to LoggerDataManager
You will be asked to confirm if the data is compensated. The
column Comp? will read “ Do” for non-compensated date,
“ Done” for compensated data and “ Not appl” for Baro data.
Logger is new to LoggerDataManager
The message will be displayed, “Settings for a new logg er will
be added” LoggerDataManager assigns the default location
settings to the new location. However, in the event that the
altitude read out from the Diver differs from the default altitude,
then the actual altitude will be saved
If the location code is in use with a different altitude assigned,
a 3 digit suffix will be affixed to the code to maintain the
uniqueness of the location codes.
The measurements have now been imported and saved.
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7

Working with measurements

7.1 About working with measurements
Once the measurements have been imported or read from the logger
then LoggerDataManager can be used to view, print and export the
measurements for use in other programs. Here we explain how you can
do that.
Measurement series that are no longer required can b e deleted.
Duplicate measurements in overlapping measurement series can be
deleted using a special function.

7.2 View measurements
In order to view measurements, you need to select a measurement
series. The measurements can then be viewed either in the form of a
table or a graph.
To view measurements:
1.

Click the tab Measurements > Loggers.
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The left-hand side of the window displays the logger-location
combinations that have been read out or imported. The default
display is sorted by location code (shown in bold face). To sort
by logger serial number double click the header of the righthand column.
The right-hand side displays the measurement series for the
selected logger location combination. The measurement
settings for the selected series are also displayed. The
measurement settings are sorted according to start date/time,
displayed in the Start column in bold type. If necessary, you
can sort these series according to import date/time. To do so,
click on the column title Read / Imported.
The Comp? column displays the barometer compensation
status. Series with statuses other than Not Applicable can be
changed in the barometer wizard (see subsection
8.2:Compensating measurements).
2.

Select the location or Diver for which the measurements are to
be viewed from the logger location list. The measurement
series that have been read out from the selected Diver are
displayed at the right-hand side of the screen.
Tip: The list may be refined by filtering the selected column.
For example, you wish to select all locations beginning with a
'g'. Select the Location column. Enter 'g*' in the Filter on
sorted column field and click the Select! button.
LoggerDataManager will display all logger- location
combinations with a location beginning with 'g'. The wildcard
(*) must be placed at the end of the filter parameter. Undo the
filter by selecting the other column, or the Filter off button.

3.

Select the series to be viewed from the list of measurement
series.

4.

Click the button Table to view the measurements in a table, or
click the button Graph to view the measurements in a graph.
The following sub- sections contain more details about viewing
measurements in a table or a graph.
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7.3 View measurements in a table
Once a measurement series has been selected it is possible to view the
measurements. Use the button Table to view measurements in a table
and print measurements in a report. The left-hand side of the screen
displays data about the measurement series, and the right-hand side
displays the actual measurements.

You can jump to the top and the bottom of the table with the two browse
buttons above the table; you can scroll through the table with the scroll
bar at the right-hand side of the table. When the selected measurement
series contains a large number of measurements, the Find function offers
a convenient method to search for the required measurement(s).
Searches can be made based on date and time.
To search for a specific measurement:
1. Click on the arrow to the right of the date field. A calendar will
be displayed.
2.

Select the required date.

3.

Click on the hour, minute or second of the time field. The
arrows to the right of the field can be used to adjust the time.

4.

Click the Find: button once the date and time have been set to
the required values.
LoggerDataManager searches for the measurement made at
that time. In the event that there is no measurement at this
time LoggerDataManager will search for the first measurement
after the specified time.
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Generate a Print preview of the measurement data via the Preview
button (see subsection 7.5 Print ).

7.4 View measurements in a graph
Use the button Graph in the toolbar to view the measurements in a
graph.

A number of modifications can be made to the presentation in the graph.
It is possible to:
•

zoom in (sub section 7.4.1);

•

increase or decrease the scales (sub section 7.4.2);

•

shift the graph (sub section 7.4.3);

•

adjust the presentation of the graph (sub section 7.4.4);

•

adjust the graph title (sub section 7.4.5).

In order to adjust the presentation of the graph you use the Settings,
Output button (tab Measurements , button Graph). Use this dialog also
to:
•

print the graph (sub section 7.5.2);

•

export the graph data or the graph as bitmap
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7.4.1 Zoom in
Details of a graph can be enlarged.
To zoom in on a graph:
1. Click the left mouse button at the top left-hand corner of the
region of the graph to be enlarged.
2.

Move the mouse cursor to the bottom right-hand corner of the
required region. Only the width of the selected rectangle is
relevant.

When the left mouse button is released the selected time
interval will be shown full scale; the vertical scales will be
adjusted to the data of the graph. The Full button will be
enabled.
To view the entire graph again:
• Click the Full button at the top right of the tab. The entire
graph will once again be displayed. The Full button will then
disable itself.

7.4.2 Increase or decrease the scales
The scales of the horizontal time axis and the vertical variable axes can
be adjusted by direct entry of the minimal and maximal value of the scale.
To set the scale of the vertical axes:
1. The fields below the Vertical axes heading at the right- hand
side of the graph displays the names and current minimal and
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maximal values of the vertical ax es. Adjust the minimal and
maximal scales as required.
2.

Click the Adapt vertical axes button. The vertical scales of
the graph will be modified accordingly. The Full button will
then be enabled.

To set the scale of the horizontal axis:
1. The fields below the Date/time from heading at the right-hand
side of the graph display the current start and finish times
employed in the presentation of the graph. Adjust the start and
finish time as required.
You can adjust the date by clicking on the arrow. The calendar
that is then displayed can be used to select the required date.
You can adjust the time by clicking on the hour, minute or
second of the time field and then using the arrows at the righthand side of the field to adjust the time.
2.

Click the Set time range button. The vertical scales of the
graph will be modified accordingly. The Full button will then be
enabled.

To show the normal scales again:
• Click the Full button at the top right- hand side of the tab. The
entire graph will once again be displayed. The Full button will
then disable itself.

7.4.3 Shift the graph
The graph can be shifted to the left or right without changing the width of
the displayed time interval.
To shift the graph:
1. Click the right mouse button on the graph, and keep the button
pressed.
2.

Move the mouse cursor in the required direction, and then
release the mouse button.

7.4.4 Adjust the curves in the graph
The appearance of the curves in the graph can be modified.
To adjust the curves:
1. Click the Settings, Output button to the right of the window.
The Editing graph dialogue box is displayed.
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2.

The tab Chart can be used to specify the measurements to be
displayed in the graph.

3.

The tab Series can be used to adjust the presentation of the
measurements in the graph.
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Use the selection field at the top of the window to select the
measurement series that is to be adjusted. It is then possible
to specify which data to display and the manner in w hich the
curve is to be displayed (the colour, line style, marker style,
and the curve width).
4.

Click the Close button to implement the changes.

7.4.5 Adjust the graph title
The title mentioned above the graph can be adjusted.
1.

Click the button Update graph title at the right of the graph.

2.

Select the text and fill in the new title.

3.

Click the OK button.

LoggerDataManager by Van Essen Instruments

Page 42

7.5 Print reports
The measurements and the graph can be printed separately .

Advanced

7.5.1 Print measurements
1.

View the measurements in the form of a table. Enter the limits
of the time interval for which the measurements have to be
printed. The arrow buttons under the Define period to be
printed heading can be used to modify the print selection.
The maximum number of measurements per print preview is
1000.

2.

Click the Preview button. The print preview is displayed in the
dialog Report preview from logger [logger
number]/[instrument code]. You can type in any changes in
the previewed report before you actually print it. The default
standard report header is defined in the “Application Manager”
tab. You can make a sub selection before printing by rightclicking and dragging. The modification procedure is given in
sub-section 4.3, Adjust program settings (field Report title ).

3.

Click the Print button to print the report. You can also close
the preview dialog without printing the report.

7.5.2 Print graphs

Advanced

Graphs can be printed using on e of two procedures:
•

immediately (a sort of 'print screen' command)

•

using a Graph dialog which offers an opportunity to modify the
printout

To print the graph immediately:
• Whilst the graph is displayed click the Standard print button.
The graph will now be printed with the default printer as
defined in Windows.
To print the graph using the dialogue box:
1. Whilst the graph is displayed click the Settings, Output button
to the right of the window. The Editing graph dialogue box will
be displayed.
2.

Click the tab Print.
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3.

The tab can be employed to specify the printer to be used, as
well as the appearance of the printout. Any changes will be
displayed immediately in the preview.
−

Select the appropriate printer, and if so required adjust
the printer settings via the Setup…button.

−

Select the page setting in the Orientation block.

−

Select the required degree of detail in the Detail block.

−

Check the Proportional box if the original proportions of
the width to length are to be retained.

4.

Click the Print button t o print the graph.

5.

Exit the Editing graph dialogue box with the Close button.

7.6 Export measurements
Both the measurements in a measurement series and the associated
graph can be exported for use in other programs, such as a spreadsheet
program. When you a re on the tab Measurements > Loggers the export
dialog is accessible via the Export selected series button on the toolbar.
The measurements can be exported to a MON, CSV, SEBA, CSV
Abstich, NITG, A4H, BOSKOP and HYMOS formatted file.
1.

Click the tab Measurements.

LoggerDataManager by Van Essen Instruments

Page 44

2.

Select the desired location- logger combination and then
highlight the measurement series you with to export. Multiple
selections may be made by keeping the Ctrl key pressed while
left- clicking on the required combination(s) and measurement
series. If you prefer working with the keyboard, keep the Shift
key pressed while you press the cursor key ↑ or ↓ .

3.

Click the Export selected series button on the tool bar.

The Export selected series dialogue box is displayed. The
default export directory is the most recently used directory;
however, it may be changed manually . See sub-section 4.3
Adjust program settings for details.

4.

Specify the folder where the exported data file is to be saved.

5.

In the Export format box specify the format to which the file is
to be exported.
If CSV-format, you must specify a field separator. You also
have the options Date & Time as a single field & Excel friendly
available.

LoggerDataManager by Van Essen Instruments

Page 45

Formats for specific users:
The export formats A4H, BOSKOP, NITG, SEBA, HYMOS and
CSV Abstich are special export formats that enable databases
of specific customers to import the measurement series.
6.

When exporting data from a Diver you should also indicate
whether the compensated or uncompensated measurement
values are to be exported. This part of the dialog is not
accessible when exporting data of BaroDiver .

7.

If you are only exporting one measurement series, indicate in
the Store as field the name under which the exported data is
to be saved. If you have selected more than one series, you
cannot enter a file name. The name is generated automatically
according to the following format:
<Location code^Logger No^ImportDate/time>.<extens ion export
format>
Example:
Grote Breide 15^25765^03-03- 04 14-5 4-01^01- 08- 27 19-00-00.CSV

You can export multiple series to all series if you widen the
date- time interval; all series at the selected location with a
start date/time AFTER or AT the entered value and an end
date- time BEFORE or At the entered value will be exported to
files with automatically generated filenames, in the specified
directory.
Tip: The field Existing export files shows the files which are
present in the selected directory. Click one of the names to
copy it to the field Store as:. Adjust the name if you like.
8.

Click the Export button. The measurements will now be
exported. Cancellation is not possible.

Now you can import, view and adjust the CSV file in Excel.

Making CSV file readable in Excel worksheet
1.

Open Excel and open the CSV file ( File menu or double click
the CSV file in Windows Explorer).

2.

Select column A from 'Date' to the last value in column A.

3.

Select the Data menu and choose option Text to columns .
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4.

Check t he radio button Separated.

5.

Click the Next button.

6.

Finally click the Finish button.

Making graph in Excel
After exporting data from LoggerDataManager in a CSV file (where date
and time are one field), it is possible to make a graph in Excel.
1.

Open Excel and open the CSV file ( File menu or double click
the CSV file in Windows Explorer).

2.

Select all columns.

3.

Choose the Insert menu and select option Chart. The Chart
Wizard dialog appears.

4.

Follow the instructions of the wizard.

7.7 Delete measureme nts
A specific measurement series stored in LoggerDataManager’s database
can be deleted once it is no longer required for whatever reason.
Subsequent to a period in which several read-outs have been made from
a logger that has not been restarted during that period,
LoggerDataManager database will contain overlapping measurement
series (duplicates). These duplicates can be deleted from the database.
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7.7.1 Delete measurement series
1.

Clic k the tab Measurements.

The left-hand side of the window displays the logger-location
combinations that have been read out. The right-hand side
displays the measurement series for the selected logger
location combination. The measurement settings for the
selected series are displayed above the measurement series.
2.

Select the logger -location combination at which a
measurement series is to be deleted. The measurement series
for the combination are displayed at the right-hand side of the
screen.

3.

Select the measurement series to be deleted.

4.

Click the Remove button. The Confirm dialogue box is
displayed.

5.

Click Yes to confirm deletion of the measurement series if you
are really sure. This action cannot be undone! Click No if you
do not want to delete the series.

7.7.2 Delete overlapping measurements (duplicates)
1.

Click the tab Measurements.
The left-hand side of the window displays the logger-location
combinations for which series are available in the database.
The right-hand side displays the measurement series for the
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selected logger-location combination. The measurement
settings for the selected series are displayed above the
measurement series.
2.

Select the logger -location combination for which overlapping
measurements are to be deleted. The measurement series for
the combination are displayed at the right-hand side of the
screen.

3.

Click the Remove duplicates button.
LoggerDataManager searches for groups of measurement
series with identical start dates and times, but with different
read-out dates and times. When such measurement series are
found, the longest measurement series will be retained. All the
shorter series will be deleted.

7.8 Merge measurement series
Sometimes it is necessary to replace a logger between two series at a
particular location. Since every logger has its unique logger serial
number, this results in two (or more) sets of measurement series for the
same location. This partition between several loggers hinders a good
analysis. To solve this problem, you can merge all or any measurements
of series at one location, within a chosen time interval, regardless of the
serial numbers of the loggers.
To merge measurement series
1. Click the tab Measurements>Loggers
2.

Select the location of which you want to merge the
measurements.

3.

Click the Merge series button. The Merge Series dialogue
appears.
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4.

Enter a start date, - time, end date and - time. You can use the
calendar by clic king the button:

You can also enter the date and time numerically, or modify
them with the arrow buttons on your keyboard.
5.

Click the Merge! button. LoggerDataManager now creates a
new series with all available measurements from the selected
location within the defined period, regardless of the loggers'
serial number.

A merged series is recognized by the ***** in the Instrument
code field. No settings like sample method and sample rate
are displayed for this series, since they may not be unique for
all measurements in the merged data.
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8

Compensation of Diver level
measurements

8.1 About the compensation of level measurements
The Diver measures the groundwater level with a highly accurate
pressure sensor that measures an absolute pressure. This pressure is
equal to the ‘weight’ of the water column above the measuring instrument
plus the prevailing air pressure. Subtracting these air pressure
measurements from the absolute pressure measurement ‘compensates’
for these air pressure variations. This is done quickly and easily using a
special LoggerDataManager wizard. Van Essen Instruments has
introduced the special BaroDiver for registering the air pressure.
The wizard uses linear interpolation for air pressure values if they are not
measured at the same time as the water level. The sampling speed of the
BaroDiver does not have to be the same as the Diver measurements it
compensates. It only has to register the variations in the atmospheric
pressure; a measurement with a fixed sampling speed of 1 per 30
minutes is usually good enough.
Example
LoggerDataManager deducts the barometric pressure (Pbarometer) from each measurement of the water pressure (Pwater), as shown in the following example.
Date

Time

P-water P-barometer Pw-Pb

22-01- 03 9:00
110
50
110- 50 = 60
22-01- 03 10:00
110
40
110- 40 = 70
22-01- 03 11:00
130
60
130- 60 = 70
Table 1: Compensation for barometric pressure

Converting measurements to a fixed reference level
Level measurements taken by a Diver are always registered in relation to
its pressure sensor. You can, however, also relate these measurements
to another level so they acquire more sig nificance. In the Netherlands, for
example, it is customary to express groundwater levels in centimetres in
relation to the New Amsterdam Ordnance Datum or to the top edge of the
monitoring well.
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Relating the measurements to the external reference level means that
you equate a compensated level measurement at a certain point in time
to the actual water level (which is determined by means of a manual
measurement, expressed in relation to an external reference level).
When this water level is below this external reference level, its numerical
value is negative.
On the basis of the distance between the water level and the reference
level, the LoggerDataManager compensation wizard determines a
correction value, called a level offset , for the location of the
measurement value in question, so that all compensated values are
related to the external reference level. This level offset is the vertical
distance between the pressure sensor and the external r eference level.

The level offset becomes a characteristic of the location of the
measurement series, which means that LoggerDataManager uses the
calculated level offset to correct not only the current measurement series,
but also all future measurement series at that particular location.
LoggerDataManager uses the calculated level offset until a new manual
measurement is entered, or until another level offset value is directly
entered by the user. A new manual measurement or a new directly
entered level offset will be required when the Diver at the location is
suspended at a different depth.
If you forget to perform a manual measurement during a measurement
series or if it is not possible to do so for one reason or another, you can
calculate the level offset yourself from the distance from the mark on the
Diver to the suspension point at the top of the monitoring well. If the top
of the monitoring well is your external reference level, the level offset is
the negative value of this distance. If you are usin g something else as an
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external reference level (NAP, for example), you have to know the height
of the top of the well in relation to it. This will enable you to calculate the
level offset in relation to this external reference level. This data can be
entered on the Locations tab in the compensation wizard..
Example
You can specify that from a manual measurement made on 22
January 2003 at 10:00 it is apparent that the water level is 200
cm below the borehole cap. The master level is then - 200.
When the elevation of the borehole cap is adopted as
reference level for the example for the barometric-pressure
compensation (see Table 1 Compensation for barometric
pressure) it can then be concluded that a compensated water
level of 70 is equivalent to –200 cm water column from the
borehole cap. The conversion of this water level to the water
level in comparison with the borehole cap will require the
application of a correction (level offset) of –270.
LoggerDataManager recalculates all values in the
compensated file using the conversion factor of –270. In the
above example this yields the following compensated and
converted level measurements:
Date

Time

Pw- Pb

22-01- 03
9:00
110-50 = 60
22-01- 03
10:00
110-40 = 70
22-01- 03
11:00
130-60 = 70
Table 2: Conversion to reference level

Water column from
the borehole cap (in
cm)
-210
-200
-200

8.2 Compensating measurements
To compensate level measurements for Divers and/or CTD Divers, use
the barometer wizard. If at least one logger requiring compensation is
known in the database, you can start the wizard in two ways via the
Barometer wizard button in the toolbar.
Note! Before compensating measurements, it is advisable to assign a
barometer location to each Diver location on the Locations tab. You will
find more information about this in subsection 4.2, Define measuring
locations.
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8.2.1 Standard compensation (without manual measurements)
1.

Open the Barometer wizard.

The dialog Barometer compensation, physical corrections and
external reference appears.

2.

The Diver measurement series that require compensation are
displayed. These measurement series had the Do status for
air pressure compensation in the Stat us column already on
the Measurements tab of the main form. A Diver
measurement series is given this status automatically when it
is read out. Measurement series that do not require
compensation (measurement series taken by a BaroDiver))
are automatically given the status Not appl. (not applicable).
If you wish to see all measurement series in the barometer
wizard, select the option All in the Select on comp. status
field. The following statuses may be present:
Status

Explanation

Do

Compensation is still to be performed.

Done

Compensation is complete.

Unfit

Compensation is not possible due to a lack of
data.

Incompl.

Series has been partially compensated despite
the lack of barometer data throughout the entire
series period.
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Status

Explanation

Not yet

Series is theoretically due for compensation but
has been temporarily excluded from
compensation by you or another user.

Series with the Not appl. status are not displayed at all in the
barometer wizard.
3.

If necessary, change the status of one or more series in the
Status column. To select more than one series, use the Shift
key in combination with the ↓ or ↑ cursor key or the Ctrl key in
combination with the left mouse button. Now choose the
required status for the selected series in the Select on comp.
status field (above the Status column). The status is changed
and the series that already had this status are displayed.

4.

If the Barolocation is not on the list, you can add it using the
Locations button. The Change location properties dialog
box appears.

Click on the Barolocation field, select the correct location and
click on Close. You cannot delete or add Barolocations here.
5.

If necessary, change the other settings of the barometer
wizard. To do so, click on the Settings button. For more
information, see subsection 8.2.2 Adjusting the settings of
barometer wizard.
Note! The selected settings will be applied to all series
requiring compensation. If you only want to compensate one
or a few measurement series with a particular setting, you
have to allocate a different status to the other series, such as
Not yet , for example.
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6.

Click on the Compensate button.

What happens now?
The compensation process starts up.
Phase 1
In the first phase, a progress bar appears in the bottom
right- hand corner.
This phase does not usually take long unless you have
selected many dozens of series with Do or Incomplete status.
During the process, the system will look for relevant barometer
locations and data, optional manual measurements and
optional offsets. Any shortcoming is reported for each series in
a log file, and series get a status ‘Unfit’.
Phase 2
If there is at least one suitable series, the second phase
begins and the progress bar starts up again.
This usually takes much longer. The duration depends on the
total number of measurements in the database (this may be in
the millions) and on the number of different barometer
locations of the Diver series to be processed .
Once the process is finished, you will see the message
’Compensation completed. See log file’, which must be
confirmed. You will now see that the barometer wizard
displays only series with the Done status, if any.
7.

Click on Close to return to the main window of
LoggerDataManager.

8.

Details of the compensation process such as the settings and
the reasons why some series are found to be unfit or
incomplete can be accessed via the Log file button in the
barometer wizard. LoggerDataManager then opens the
Compensation.Log text file with Windows’ Notepad. This file is
stored in the Exe subfolder, in C:\Program Files \LDM\ Exe, for
example.

8.2.2 Adjusting the settings of barometer wizard
You can alter a number of options for the compensation process in the
barometer wizard. To do so, click on the Settings button. The
Compensation settings dialog box appears:
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Once you have altered the settings, close the box with the OK button.
The LoggerDataManager saves the settings for subsequent sessions.
Using an external reference
You can select one of the follow ing options:
•

Calculate offsets from manual measurements
On page 51, you will find an explanation of how to use offsets
from manual measurements. In this case, the compensation
wizard will display extra columns in the list of measurement
series for entering manual measurements. Double- click on a
cell in the column to enter a value (which may be a negative
figure). Manual measurements that were entered on tab
Logger settings > Read/program logger before a series was
read out for the logger, are automatically copied to the correct
series in the list below. They can be modified here, if
necessary.
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The program checks whether the date and time of the manual
measurement are within the interval of the measurement
series and - if the barometer data is incomplete - within the
interval of the barometer series. If not, the status is changed to
Unfit and no compensated values are calculated for that
particular series. If the series is found to be ‘fit’, a level offset is
calculated for the location of the measurement series that
indicates the height of the Diver’s pressure sensor in relation
to the external reference level. This offset is not only used for
the compensation of the series, but is also assigned to the
location of that series. This can be verified in the location lists.
As long as the Diver remains suspended at the same height, a
new manual measurement is theoretically unnecessary.
Note! If the date and time of the manual measurement are not
between the start date/time and the end date/time of the series
in question (in the Start and End columns), the data in the
Value, Date and Time columns will be displayed in red.
•

Use the known location level offsets
If your Diver has been suspended on a stainless steel cable or
a Direct Read Cable (DRC), you can enter a value via
Locations in the Level offset field. If no value has been
entered or the value is ‘0’, the series at this location will be
given the status ”Unfit".
The value in the Level offset field indicates the exact
elevation of the Diver’s pressure sensor in relation to an
external reference level.
If the DRC is 200 cm long, for example, the distance between
the top of the monitoring well and the Diver’s pressure sensor
is exactly 200 cm. If the elevation of the head of the
monitoring well was measured at +100 cm NAP, the value you
enter in the Level offset field is: -100 cm (+100 cm NAP –
200 cm = -100 cm NAP). This method makes the use of
manual measurements unnecessary.!

•

Use BaroData only
The result is a water column height in relation to the pressure
sensor. The advantage of this is that a measurement series
can never be found unfit due to the absence of a manual
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measurement or a level offset equal to zero. The lack of a
barometer location and/or a lack of data may still result in the
assignment of the Unfit status.
•

Use known location’s level offsets only; ignore barometer
data
For some pump tests with a short duration, it is pointless to
use barometer compensation and it is skipped for that reason,
as are manual measurements. Only level offsets of the
measurement series locations are used to establish a
relationship with an external reference level.

About the gravitational acceleration
2
Divers are programmed with a gravitational acceleration of 9.806 m/s .
The gravitational acceleration is a proportionality factor used by the Diver
to convert the pressure measured by the pressure sensor to an
equivalent water level above the pressure sensor.
The gravitational acceleration is dependent on the latitude. The
gravitational acceleration varies by about 0.5% between the Pole and the
Equator (with latitudes of 90 and 0 degrees). The pressure sensor has an
inaccuracy of 0.1% of the full range. Consequently, it may be beneficial to
correct the level measurements for a difference in the gravitational
acceleration. For this, you can enter the latitude; LoggerDataManager will
then calculate the appropriate gravitational acceleration.
However, the gravitational acceleration is also dependent on the
inhomogeneity of the earth. In situations in which an extremely accurate
correction is required, and a more accurate gravitational acceleration is
available for the location than the figure calculated from the latitude, then
this value can also be entered and will be used by LoggerDataManager,
overruling the default value of the Diver AND any calculated value.
To enter a correction for gravitational acceleration:
1. In the barometer wizard tick the Use instead: box.
2.

Enter the degree of latitude of the measuring area in the from
latitude field. LoggerDataManager calculates the
corresponding gravitational acceleration; the value is shown in
the calc. grav. acceleration field.
or
Enter the correct gravitational acceleration in the or entered
grav. acceleration field.
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8.2.3 Entering barometer levels manually
It is sometimes necessary to add air pressure measurements manually to
a location in LoggerDataManager, because the barometer was not
started in time or stopped to early because its memory was full, for
example. Manually entered barodata entered at a particular Barolocation
will be used by the compensation wizard like any normal barometer
series at that location.
A condition for doing so is that the location to which you want to assign
barometer levels manually is included on the Locations tab.
1.

In the menu bar, click on File > User entry barodata (or use
hotkey Ctrl+B). The dialog box Entry of Meteo-baro data
appears

The first time you wish to enter barometer data in this way, the
form will be empty. Only the system date and time have been
filled in. If measurements have been added previously, you
can select a series from the MEASUREMENT SERIES
overview and then add or delete air pressure measurements.
2.

In the Location column, click on the empty field and select the
location that relates to the barometer levels you wish to enter.
LoggerDataManager then automatically creates a
measurement series to which you can assign the air pressure
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levels. Only one series can be entered for each location; the
intervals between consecutive measurements do not have to
be constant. The other fields in the MEASUREMENT SERIES
overview cannot be changed. The Number column indicates
how many air pressure measurements have been entered
manually for the location in question.
Note! If you select a location where no BaroDiver is registered
(yet), this location will assume the character of a Barolocation.
To use this series for compensation, you should assign this
Barolocation to the locations of the series to be compensated.
It is, however, inadvisable to use a location where normal
Divers are already registered, since this may cause confusion.
3.

Now enter your manual me asurement in the Date/Time and
Pressure fields. The air pressure is always entered in mbar.

4.

Click on the <<Insert button. The measurement is added to
the MEASUREMENTS list and the pressure is converted into
a water column in the selected level unit.
Each time you add a measurement, the values in the Start,
End and Number columns are automatically modified (in the
MEASUREMENT SERIES overview).
If you want to delete an air pressure measurement, click on
delete:

You cannot delete a complete measurement series in the
Entry of Meteo-baro data dialog. This is done in the main
LoggerDataManager window, on the Measurements tab. You
can recognise a location with measurement series that have
been entered manually by the 'METEO' code in the Logger
column.
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9

Calibrating a Diver

9.1 About calibrating a Diver
Advanced

The CTD- Diver, the only Diver type requiring calibration, needs to be
recalibrated regularly to guarantee their reliability. You can read more
about the calibration in the product manual of the Diver.

9.2 Calibrate a CTD-Diver
It is extremely easy to calibrate CTD- Divers (DI261/263/265) with
LoggerDataManager: the calibration wizard does it automatically for you .
You only need to place the CTD- Diver in a calibration solution with a
standard conductance. These solutions can be obtained from suppliers of
laboratory equipment.
The CTD- Diver can be calibrated at a maximum of four points
The solution must have a temperature between 5°C (41°F) and 30°C
(84°F). It is, therefore, advisable to place the fluid(s) in the room where
the calibration is to take place long before actual calibration to allow the
fluid temperature to stabilise.

9.2.1 Calibrating a CTD-Diver
Note! For all concentrations that you select for the CTD- Diver in the CTD
calibration wizard, the calibration fluids should be put out ready for
calibration. The CTD- Diver should then be immersed in the first fluid, i.e.
the one with the lowest concentration. Then calibrate the selected
calibration points in a sequence of increasing conductivity.
A CTD- Diver (DI261/263/265) is calibrated as follows:
1. Connect the CTD- Diver to your computer. See section 5.2
Connect a Diver to your computer for details.
2.

Click the button Read settings from connected logger to
read the sample settings from the Diver. See section 5.3 Read
out measurement settings for details.
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If the CTD- Diver is not in database, the settings are still saved
and displayed on the Logger settings > Read/program
logger tab. At the bottom of the screen on the left of the Live
update subtab you will see the current status of the connected
CTD- Diver. This must be STOPPED to be able to calibrate. If
it is not, you can use the active Stop button. You can also
read out any measurements present, as described in
subsection 5.3 Read out measurement settings .
Note! Problems reading out data? Look for possible solutions
in Chapter 10 Solving problems .
3.

Start the calibration wizard with the CTD calibration wizard
button in the toolbar or via the menu bar with Communication
> Calibrate CTD. This button and menu option are only active
when a CTD- Diver has been selected in the Logger settings
> Read/program logger tab.

The Calibration of CTD dialog box appears.

4.

Select one or more calibration solutions for which you wish to
calibrate the CTD- Diver. Your selection is stored in the
program settings until the next session.
Measurements will be most accurate near the selected
calibration points. If you are measuring in water w ith a value
between two calibration points, 8,000µS/cm for example, it is
enough to calibrate at two points: 5,000µS/cm and
12,880µS/cm.
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If you want evenly spread accuracy across the entire
measurement range, you should select all calibration points
within that range. If you are only interested in a high degree of
accuracy of a small section of the measurement range, near
1,413µS/cm for example, only select calibration point 1,413
µS/cm.
5.

Click on Proceed>>. This contains information on what
calibration fluid the CTD- Diver should be immersed in.

6.

If you think the temperature is suitable, click on OK. The
following step appears:

The bottom stabilization bar displays a one- minute interval in
which the CTD- Diver is given the chance to create a stable
calibration at the current calibration point. The progress of the
stabilization is shown in the top stabilization bar. You can stop
the process by clicking on the Cancel button.
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Aborted calibration
If the calibration fails because the temperature was not stable,
wrong solution used or process aborted by user, you will see
the following message:

If you click on OK, the CTD- Diver is restored to its original
condition and the wizard is closed.
Successful calibration
If the CTD- Diver does converge on the calibration point within
the set time, one of two situations will occur:
•

you will see a message telling you that the calibration has
been successful.

•

the immersion step for the next calibration point appears if
you have set more than one calibration point in the first
step.

Once all of the calibration points have been dealt with, you can
close the wizard by clicking on Cancel or return to the first
step in the wizard by clicking on Another CTD. This enables
you to calibrate several CTD of the same type without leaving
the CTD calibration wizard.
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grammar

9.3 Calibration History:
The calibration history is accessed by clicking the show history
button on the calibration template.

A graph showing dates and cell constants for the connected
CTD- Diver will then by displayed.
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10 Solving problems
10.1 Communi cation interrupted
LoggerDataManager will inform you with a message if communication between the
computer and the Diver is disturbed. For instance, when there is no Diver
connected at all.
You can confirm the message, take action to solve the problem and then try again.
Communication may be disturbed for the following reasons:
•

The read out unit is not properly connected to the computer.
Action: Ensure the read-out unit is connected to the correct serial port
or select the correct port in LoggerDataManager. See the section 4.3,
Adjust program settings for details.

•

LoggerDataManager tried to communicate with the Diver just as it was
taking a measurement.
Action: Confirm the message and try again.

•

The Diver is not properly connected to the read out unit.
Action: Ensure that the optical connectors on both the Diver and the
read-out unit are clean. If not, you can clean them with a soft cloth.

10.2 Incidental communication error
If the sample rate is less than 10 seconds, there is a chance a communication error
occurs when reading out the Diver. This error is due to the way your personal
computer deals with the communication by the RS232 port. Communication may
be disturbed for the following reasons:
•

There is not enough delay in the communication between the Diver and
the computer.
Action:
1. Go to Windows Explorer.
2. Open the d irectory Program Files and open subdirectory LDM\ Exe
(C:\Program Files\LDM\Exe).
3. Open the file LDMSettings.ini in Notepad or WordPad.
4. Add as last line: Delay=35
5. Save the file and close Notepad or WordPad.
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•

The configuration of the COM port in your computer for receiving and
transmitting data is set too high (FIFO buffers).
Action: To resolve this problem it is necessary to change the settings
of the COM port. Instructions for Windows XP:
1. Go to Start > Control Panel.
2. Select System and click the tab Hardware.
3. Click the button Device Manager.
4. Select Ports, COM1 (or COM2).
5. Click on the tab Port Settings on the button Advanced.
6. Select Receive Buffer or Transmit Buffer and move the bar from
high to low.

10.3 Corrupt database
When the database is damaged, e.g. because LoggerDataManager has been
aborted during a major database transaction with the Windows Task manager or
with CTRL+ALT+DEL (see section 7.4), you can restore the database with the
LDMrepair tool. You can create an error log during the repair process. This log file
may help you to determine what is wrong with the database.
Start LDMrepair
1.

Click the Start menu.

2.

Select Programs > LDMrepair.

or:
Double- click the LDMrepair icon on your desktop:

The window Paradox tables check and repair utility – ver 4.41
appears.
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Repair the database
1.

The default setting in the Select directory field is the path in which
LDMrepair is installed (e.g . C:\Program Files \LDM\ Exe\DB). Use the
Browse button, if need be, to select the directory with the relevant
database tables. From then on LDMrepair checks and repairs the
Paradox tables in the selected directory.

2.

Set the rebuild scope to Rebuild the corrupted tables or Rebuild all
tables. Leave the option Select tables to process blank, or on <ALL
TABLES>.

3.

Check the Pack tables field if you want to remove all deleted records in
LoggerDataManager (deleted records are not actually deleted in
LoggerDataManager, but marked as 'deleted' so you do not see those
records anymore). Checking this option will reduce the disk space of the
database.
Note! The Select alias option and field can be ignored.
LoggerDataManager databases are not equipped with alias
identification. However, they could be used to select and repair other
Paradox databases on your computer, if these databases have an Alias
identification.
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4.

Click the Start button. LDMrepair checks all tables in the
LoggerDataManager database directory and r epairs the tables if
needed. In the progress bar you can see the status of the check-andrepair action.

5.

Check the option Log to file if you want to append the list of errors (if
any are found) to a log file.

At the end the result will be shown above the progress bar, e.g.:

If errors are found, the message “There were errors” is displayed
instead. At the right of the tab Options another tab appears, with
caption Errors. A list of the found errors is displayed on the tab sheet
under this tab. If you had checked the option Log to file , this list of
errors -with date and time- is appended to the error log file. This file is
an ordinary text file, that can be viewed with Windows’ Notepad by
clicking on button View log . You could mail this file to your supplier, if
necessary.
Note! If the database cannot be repaired with LDMrepair (this is a very rare worst
case scenario), you might consider importing the MON- file backups into
LoggerDataManager again from the backup directory (see section 4.3 for settings).
You must be sure that you still have MON-file backups of all data; first you must
delete ALL loggers from the list of allocated loggers and ALL series of
measurements, then repair and pack the database with LDMrepair before you
start importing the MON-file backups. If you don’t want to do this yourself, consult
your supplier.
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Appendix – System requirements

Processor

Pentium® or better

Operating system

Windows 2000 or XP

Internal memory needed

10 MB

Disk space needed

7 MB or more

Display

Pointing device

•

VGA : 1024 x 768, 256
colors; at lower
resolutions you can still
scroll through the user
interface.
• screen diagonal: 12 inch
minimum 14 inch
recommended
mouse or other pointing device
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